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Kodak Alaris Inc. i NewSoft wspólnie opracowali dla Ciebie Presto! 
PageManager 9 – aplikację do skanowania. Aplikacja ta jest systemem 
zarządzania dokumentami, która umożliwia szybkie i łatwe wykonywanie 
zadań skanowania, takich jak:

• skanowanie korespondencji przychodzącej od klientów i udostępnianie jej
współpracownikom w oddziale firmy;

• tworzenie przeszukiwalnych plików PDF na podstawie wydrukowanego
raportu;

• skanowanie faktury, a następnie jej wydrukowanie lub wysłanie faksem;

• skanowanie zdjęcia w celu dodania go do prezentacji.

Presto! Pagemanager obsługuje następujące skanery Kodak:

• Skaner Kodak ScanMate i940

• Skanery Kodak i1150 oraz i1180

• Skanery Kodak i2400, i2600 i i2800 

Instalacja 1. Przejdź do strony: www.kodakalaris.com/go/docimaging.

2. Kliknij ikonę Document Scanners (Skanery dokumentów), kliknij pole
Scanner Selector (Wybór skanerów) i wybierz swój skaner.

3. Kliknij Support tab (zakładkę Obsług) i kliknij Drivers & Downloads
(Sterowniki i pliki do pobrania).

4. Wybierz sterownik Mac dla swojego skanera i wprowadź numer seryjny.

5. Pobierz i zapisz na pulpicie .dmg.gz.

6. Dwukrotnie kliknij plik .dmg.gz.

7. Dwukrotnie kliknij plik .dmg.

8. Kliknij dwukrotnie ikonę Package (Pakiet).

9. Kliknij przycisk Continue (Kontynuuj). Zostanie wyświetlony ekran powitalny.

10. Kliknij przycisk Continue (Kontynuuj).

11. Wybierz język / region, a następnie kliknij przycisk Continue (Kontynuuj).
Zostanie wyświetlony komunikat z monitem o przeczytanie i
zaakceptowanie Umowy licencyjnej na oprogramowanie.

12. Aby kontynuować, kliknij przycisk Agree (Zgadzam się).

13. Kliknij przycisk Install (Instaluj).
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14. Jeśli komputer jest zabezpieczony hasłem, zostanie wyświetlony monit 
o wprowadzenie hasła. Wpisz hasło. a następnie kliknij przycisk Install 
Software (Instaluj oprogramowanie). Instalacja oprogramowania 
rozpocznie się.

15. Po zakończeniu instalacji kliknij przycisk Close (Zamknij).

16. Zamknij okno Folder, PageManager otworzy się automatycznie.

UWAGA: Jeśli PageManager nie otworzy się automatycznie, na pasku 
Menu kliknij Go (Idź do) i wybierz Applications (Aplikacje).

17. Kliknij dwukrotnie ikonę folderu Presto! PageManager 9.26 następnie 
dwukrotnie kliknij PageManager 9.26, aby otworzyć aplikację.

Funkcje Poniżej przedstawiono funkcje Presto! PageManager:

Thumbnail and List View (Widok miniatur i listy — umożliwia wyświetlanie 
i porządkowania plików w formie miniatur lub listy.

Document Pallet (Paleta dokumentów) — umożliwia przeciąganie plików 
z różnych folderów to jednego folderu wirtualnego, konwertowanie ich do PDF 
i wysyłanie pocztą elektroniczną do określonej lokalizacji lub do adresata.

Scan Buttons (Przyciski skanowania) — umożliwiają skanowanie materiałów 
w różnych formatach i otwieranie ich za pomocą określonej aplikacji bez 
uprzedniego otwierania PageManager. 

Folders (Foldery) — umożliwia łatwą organizację plików, tak jak w Finder 
(Wyszukiwacz). 

Quick Link (Szybkie łącze) — przeciągnij tu folder w celu utworzenia 
ulubionych grup. 

Document, Image, Audio and Video Viewers — (Wyświetlarki dokumentów, 
obrazów, plików audio i wideo) – w czasie podglądu dokumentów i obrazów 
możesz zobaczyć je za pomocą PageViewer, bez otwierania innych aplikacji. 
W przypadku plików audio i wideo PageViewer otworzy powiązaną z tymi 
plikami aplikację. 

OCR — przekształca zeskanowany tekst na tekst odczytywany przez komputer 
(Optyczne rozpoznawanie znaków, OCR). 

Search — (Szukaj) łatwe wyszukiwanie plików według nazwy lub rozszerzenia 
plików. 

Annotation Tools (Pliki adnotacji) — nie wpływając na oryginalny plik dodaje 
adnotacje przy użyciu takich narzędzi, jak pieczątka, narzędzie do podświetlania. 
linia odręczna, linia prosta i karteczka przylepna.
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Image Editing Tools (Narzędzia edycji obrazów) — poprawia jakość zdjęć 
przy użyciu zestawu narzędzi do obróbki obrazów: przycinania, obracania, 
pochylania, odwracania kolorów, modyfikacji jasności i kontrastu, modyfikacji 
kolorów i usuwania szumów. 

Dodatkowa 
dokumentacja

Oprócz tego Podręcznika użytkownika stronie internetowej Kodak Alaris dostępna 
jest również następująca dokumentacja:

• Scanning Setup Guide (Podręcznik konfiguracji skanowania — do skanera 
dołączono TWAIN Datasource. Podręcznik konfiguracji skanowania 
zawierają opis sposobu korzystania z podstawowych funkcji przetwarzania 
obrazu. Można go pobrać w formacie PDF ze strony internetowej Kodak 
Alaris (www.kodakalaris.com/go/docimaging).
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2 Praca z PageManager

Spis treści Ekran główny .............................................................................................2-2
Pasek menu ...............................................................................................2-3

Menu Presto! PageManager menu .....................................................2-3
Menu File (Plik) ...................................................................................2-3
Menu Edit (Edycja)..............................................................................2-4
Menu View (Widok) .............................................................................2-5
Menu Tools (Narzędzia) ......................................................................2-5
Menu Help (Pomoc) ............................................................................2-6

Pasek narzędzi Polecenia..........................................................................2-7
Zmiana ustawień paska narzędzi Polecenia .......................................2-8

Obszar wyświetlania ..................................................................................2-8
Używanie folderów.....................................................................................2-9
Filtry ...........................................................................................................2-9
Używanie Palety dokumentów .................................................................2-10

Zmiana ustawień Palety dokumentów............................................... 2-11
Pasek stanu .............................................................................................2-12
Wybieranie źródła ....................................................................................2-12
Zmiana domyślnych ustawień skanowania ..............................................2-13
Akwizycja obrazów ze skanera ................................................................2-15
Przyciski skanowania Presto! ..................................................................2-15

Opcje menu Scan buttons (Przyciski skanowania) ...........................2-16
Ustawianie preferencji przycisków skanowania Presto!....................2-17
Zakładka Scan Settings (Ustawienia skanowania) ...........................2-17
Lista zadań........................................................................................2-18
Zakładka Scan to Destination (Skanuj do miejsca docelowego) ......2-19

Drukowanie plików i wysyłanie ich faksem ..............................................2-21
Konfigurowanie druku i wysyłanie faksem ........................................2-21
Drukowanie .......................................................................................2-21
Wysyłanie faksem .............................................................................2-22
Używanie PrintFun............................................................................2-22
Przenoszenie faksów do folderu .......................................................2-25

Robienie opcji zapasowych plików...........................................................2-26
Odzyskiwanie plików................................................................................2-26

Presto! PageManager umożliwia uzyskiwanie, podgląd, edycję, organizację, 
zapisywanie i eksport plików. Niniejszy rozdział zawiera informacje i procedury 
do pracy z PageManager.

PageManager zawiera trzy podstawowe elementy:

• Main screen (Ekran główny) — umożliwia przeszukiwanie, rozpoznawanie 
i eksportowanie plików. Więcej informacji na temat Ekranu głównego 
zawiera następny punkt.

• PageViewer — umożliwia oglądanie i edycję plików oraz opatrywanie ich 
adnotacjami. Więcej informacji zamieszczono w Rozdziale 3, Praca 
z PageViewer.



2-2 A-61830_pl  Czerwiec 2014 r.

• Przyciski skanowania — przyciski te umożliwiają szybkie, jednoetapowe 
operacje. Zobacz punkt zatytułowany „Przyciski skanowania Presto!” 
w dalszej części rozdziału.

 Ekran główny Ekran główny składa się z następujących elementów:

• Pasek Menu — umożliwia wprowadzanie poleceń związanych z obsługą 
PageManager.

• Pasek narzędzi Polecenia — zawiera najczęściej używane polecenia. 
Polecenie na tym pasku narzędzi są dostępne także z paska Menu.

• Obszar wyświetlania — wyświetla pliki w trybie podglądu Miniatury lub 
Lista. 

• Foldery — wyświetla organizację folderów w Twoim komputerze.

• Filtry — umożliwiają wybór typu plików w obszarze roboczym. Dotyczy to 
obrazów JPEG, PNG, BMP, GIF, TIFF oraz plików PDF, RTF, HTML i XML. 
-Kliknij dwukrotnie pasek Fitry, aby spowodować wyświetlenie lub ukrycie 
plików w folderach.

• Paleta dokumentów — pozwala na wybranie plików pochodzących z różnych 
folderów i przeciągnięcie tych plików do Palety dokumentów, a następnie 
przekonwertowanie w PDF i przesłanie do folderu lub poczty elektronicznej.

• Pasek stanu — umożliwia wyświetlenie całkowitej liczby plików i informacji 
o miejscu na dysku w odniesieniu do plików wyświetlanych w obszarze 
Display (Wyświetlacz).

Więcej informacji na temat każdego z tych elementów zawierają następne 
punkty.
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Pasek menu Pasek Menu zawiera opcje menu Presto! PageManager, Plik, Edycja, Podgląd, 
Narzędzia i Pomoc. 

UWAGA: Niektóre opcje na pasku Menu mogą być niedostępne.

Menu Presto! PageManager Menu Informacje o Presto! PageManager — zawiera następujące opcje.

Informacje o Presto! PageManager — zawiera informacje o Twojej wersji 
PageManager, umożliwia ustawienie preferencji, ukrycie/wyświetlenie aplikacji 
PageManager i wyjście z aplikacji PageManager.

Preferences (Preferencje) — umożliwia wybór języka OCR.

Services (Usługi) — zawiera opcje No Services Apply (Nie mają zastosowania 
żadne usługi) lub Services Preferences (Preferencje usług). Jeśli wybierzesz 
Services Preferences (Preferencje usług), zostanie wyświetlone okno dialogowe 
Keyboard (Klawiatura), w którym można zmienić wiele różnych preferencji.

Ukryj Presto! PageManager9 — po wybraniu aplikacja jest minimalizowana 
do Palety dokumentów. 

Hide Others (Ukryj inne) — minimalizuje wszystkie inne aplikacje do Dock 
(Dokowanie).

Show All (Pokaż wszystko) — powoduje ponowne wyświetlenie wszystkich 
zminimalizowanych wcześniej aplikacji.

Quit Presto! PageManager9 (Opuść Presto! PageManager9) — zamyka 
aplikację PageManager.

Menu File (Plik) Menu File (Plik) zawiera następujące opcje.

New Folder (Nowy folder) — umożliwia utworzenie nowego folderu.

Go to My PageManager (Idź do mojej aplikacji Pagemanager) — jeśli Twoją 
aktualną lokalizacją folderu nie jest My PageManager, kliknięcie Go to My 
PageManager (Idź do mojej aplikacji Pagemanager) spowoduje otwarcie 
i wyświetlenie folderu My PageManager (Moja aplikacja PageManager.

Open With (Otwórz przy użyciu) — umożliwia otwieranie plików przy użyciu 
innej aplikacji.

Save As (Zapisz jako) — umożliwia zapisanie pliku z inna nazwą.

Backup (Zrób kopię zapasową) — zapisuje kopie zapasowe plików. Zobacz 
punkt „Robienie kopii zapasowej plików” w dalszej części tego rozdziału. 

Restore (Odzyskaj) — otwiera kopie zapasowe plików. Zobacz punkt 
„Odzyskiwanie plików” w dalszej części tego rozdziału. 

Acquire Image Data (Pobierz dane obrazów) — umożliwia skanowanie 
dokumentu(ów) w czasie używania Presto! PageManager. Więcej informacji 
można znaleźć w punkcie „Pobieranie obrazów ze skanera” w dalszej części 
niniejszego rozdziału.

Select Source (TWAIN) (Wybierz źródło(TWAIN) — powoduje wyświetlenie 
okna Select Source (Wybierz źródło), umożliwiającego wybranie skanera do 
skanowania.

Scan Settings (Ustawienia skanowania) — powoduje wyświetlenie okna 
Default Scan Options (Domyślne opcje skanowania), umożliwiającego zmianę 
dowolnego z ustawień w tym oknie lub kliknij Manage Profiles (Zarządzaj 
profilami), aby wyświetlić Setting Shortcuts (Skróty ustawień), gdzie można 
dokonać dodatkowych zmian (np. rozdzielczość. Więcej informacji można 
znaleźć w punkcie „Zmiana domyślnych opcji skanowania” w dalszej części 
niniejszego rozdziału.
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Page Setup (Ustawienia strony) — umożliwia zmianę ustawień drukarki lub 
faksu.

Print (Drukuj) — powoduje wyświetlenia okna dialogowego Print (Drukuj) (lub 
Fax - Faks), umożliwiając wydrukowanie dokumentem lub wysłanie go faksem.

PrintFun — umożliwia drukowanie takich obrazów, jak zdjęciami naklejki lub 
katalogi. Można wybrać ile kopii danego obrazu ma zostać wydrukowanych lub 
wybrać Set for all (Wybierz dla wszystkich) i wprowadzić liczbę kopii, która 
chcesz wydrukować w przypadku poszczególnych obrazów. Zobacz punkt 
„Używanie PrintFun” w dalszej części niniejszego rozdziału.

Get Info (uzyskaj informacje) — powoduje wyświetlenie okna dialogowego 
File info (Informacje o plikach), w którym widoczny jest podgląd wybranego 
pliku (np. ścieżka pliku, typ pliku, rozmiar pliku itd.) i umożliwia dodanie 
komentarzy do pliku oraz zablokowanie/odblokowanie pliku.

Menu Edit (Edycja) Menu Edit (Edytuj) zawiera następujące opcje.

Undo (Cofnij) — anuluje ostatnią operację edycji.

Redo (Powtórz) — powtarza ostatnią operację edycji.

Cut — (Wytnij) usuwa wybrany plik lub część pliku z wyświetlacza i umieszcza 
go w schowku.

Copy — (Kopiuj) umożliwia skopiowanie pliku i części pliku bez usuwania go 
z wyświetlacza i umieszcza go w schowku.

Paste (Wklej) — powoduje wklejenie informacji, które zostały skopiowane lub 
wycięte do obszaru, w którym aktualnie znajduje się kursor.

Delete (Usuń) — umożliwia usunięcie wybrane informacje.

Select All (Wybierz wszystko) — wybiera wszystkie pozycje w obszarze 
Wyświetlacza.

Start Dictation (Rozpocznij dyktowanie) — jeśli chcesz korzystać z tej funkcji, 
musisz włączyć Dictation and Speech (Dyktowanie i mowa) w Preferencjach 
Systemu. Skorzystaj z tej opcji, aby podyktować to, co chcesz powiedzieć, 
treść ta zostanie zamieniona na plik tekstowy.
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Special Characters (Znaki specjalne) — wyświetla listę znaków specjalnych 
i symboli, które można dodać do Ulubionych.

Menu View (Widok) Menu View (Widok) zawiera następujące opcje.

As Thumbnails (Jako Miniatury) — powoduje wyświetlanie plików w postaci 
miniatur. Przy pierwszym uruchomieniu PageManager, wyświetlany jest widok 
Miniatur. Każda miniatura odpowiada plikowi w wybranym folderze.

As List (Jako Lista) — powoduje wyświetlanie plików jako pozycji listy. 
Informacje zawierają: nazwę, typ, rozmiar, komentarz, datę modyfikacji i datę 
utworzenia.

Arrange By (Ułóż według) — powoduje ułożenie miniatur w porządku malejącym 
lub rosnącym – według nazwy, typu, rozmiaru, komentarza lub daty.

Hide/Show Toolbar Pokaż/Ukryj pasek narzędzi — powoduje wyświetlenie 
lub ukrycie paska narzędzi.

Customize Toolbar (Dostosuj pasek narzędzi) — otwiera okno dialogowe, 
które umożliwia dostosowanie pozycji na pasku narzędzi do potrzeb 
użytkownika. Więcej informacji można znaleźć w punkcie „Zmiana ustawień 
paska narzędzi Polecenia” w dalszej części niniejszego rozdziału.

Refresh (Odśwież) — aktualizuje obszar Wyświetlacza tak, aby odzwierciedlać 
najnowsze zmiany.

Tool menuMenu narzędzi Menu Narzędzia zawiera następujące opcje.

Stos — umożliwia grupowanie plików w stos. Zgrupowane pliki będą zaopatrzone 
w strzałki W górę i W dół, umożliwiające przeszukiwanie plików w stosie.

Gdy pliki są grupowane w stos, można je wszystkie oglądać w PageViewer 
i grupowo zmieniać nazwę plików, nadając im numer i niepowtarzalny 
przedrostek. 

W celu zgrupowania plików w stos, należy ułożyć pliki, które mają być 
zgrupowane, przeciągając je jeden na drugi i wybrać Tools>Stack 
(Narzędzia > Stos). Na miniaturze stosu pojawi się ikona stosu. 

Unstack (Rozgrupuj stos) — rozkłada stos plików. 

W celu rozłożenia stosu plików, wybierz pliki, które chcesz rozgrupować 
i kliknij, aby je rozgrupować. Możesz także kliknąć Tools>Unstack 
(Narzędzia > Rozgrupuj stos) i kliknąć All Pages (Wszystkie strony), co 
spowoduje rozdzielenie wszystkich pogrupowanych w stos plików lub wybrać 
Current Page (Bieżąca strona) w celu oddzielenia wybranego pliku ze stosu.

Perform OCR (Przeprowadź OCR) — otwiera Presto! PageViewer, umożliwiając 
wykonanie OCR (Optyczne rozpoznawanie znaków) na pliku. Więcej informacji 
można znaleźć w podrozdziale „Stosowanie OCR” w rozdziale 3.

Merge All Files into a Single PDF (Połącz wszystkie pliki w jeden plik PDF) — 
umożliwia połączenie wybranych plików w plik PDF. Po wybraniu tego polecenia 
zostaje wyświetlone okno dialogowe Save as (Zapisz jako): 
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Zostaniesz poproszony o wprowadzenie nazwy pliku i miejsca, w którym ma 
być zapisany plik PDF. Kliknij przycisk Options (Opcje) w celu wybrania jednej 
z następujących opcji:

• Save Document As (Zapisz dokument jako): Zapisz wszystkie dokumenty 
w jednym pliku pdf: jest to jedyna dostępna opcja. 

• Rozmiar dokumentu: możesz zapisać plik korzystając z opcji Original 
Size (Rozmiar pierwotny) lub Fit to Page (Dopasuj do strony).

• OCR Option (Opcja OCR): możesz zapisać plik jako Image, Text and 
Image (obraz, tekst i obraz) lub Text Under Image (tekst pod obrazem).

• Język OCR: umożliwia wybranie języka, który będzie używany do 
przetwarzania OCR.

Split the Selected PDF File (Podziel wybrany plik PDF) — umożliwia podział 
wybranego pliku PDF na stos odrębnych stron. Zostaniesz poproszony 
o wprowadzenie nowej nazwy pliku i miejsca, w którym ma być zapisany.

Merge All Images into a Multi-page TIFF (Połącz wszystkie pliki w jeden plik 
TIFF) — umożliwia połączenie wszystkich wybranych plików w plik TIFF 
zawierający wiele stron. Zostaniesz poproszony o wprowadzenie nazwy pliku 
i miejsca, w którym ma być zapisany wielostronicowy plik TIFF.

Split the Selected Multi-page TIFF (Podziel wybrany plik wielostronicowy 
TIFF) — umożliwia podział wybranego pliku wielostronicowego TIFF na 
odrębne strony. Zostaniesz poproszony o wprowadzenie nowej nazwy pliku 
i miejsca, w którym ma być zapisany.

Zmień nazwę — umożliwia zmianę nazwy wybranego pliku.

Batch Rename (Zmień nazwę wsadu) — umożliwia zmianę nazwy wybranego 
pliku wsadowego.

Slide Show (Pokaz slajdów) — powoduje wyświetlenie wybranych plików 
graficznych w czasie pokazu slajdów.

Log In to Google Docs (Zaloguj się do Google Docs) — powoduje 
wyświetlenie okna dialogowego Google Docs, w którym można wprowadzić 
swoją Nazwę użytkownika i Hasło uzyskują w ten sposób dostęp do Gogle 
Docs.

Log In to Evernote (Zaloguj się do Evernote) — powoduje wyświetlenie okna 
dialogowego Evernote, w którym można wprowadzić swoją Nazwę użytkownika 
i Hasło uzyskując w ten sposób dostęp do Evernote.

Import Old Database (Importuj starą bazę danych — umożliwia import 
wcześniejszej bazy danych.

Menu Pomoc Menu Help (pomoc) zawiera następujące opcje.

Search (Szukaj) — umożliwia szukanie wśród pozycji menu i tematów pomocy.

Link to NewSoft Website Łącze do strony internetowej NewSoft— zapewnia 
dostęp do strony internetowej New Soft, na której można aktualizować produkty.

Help (Pomoc) — otwiera plik pomocy online.
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Pasek narzędzi 
Polecenia 

Pasek narzędzi zawiera często używane funkcje. Funkcje te są dostępne 
także z paska Menu. Pozycje na pasku narzędzi Polecenia będą się różnić 
w zależności od typu wybranego dokumentu. 

Domyślnie na pasku Poleceń PageManager pojawiać się będą następujące 
ikony. 

Czerwony: zamyka aplikację.
Żółty: redukuje wyświetlanie do miniatury w doku.
Zielony: powiększa (lub zmniejsza) rozmiar wyświetlacza.

Backward/Forward (Wstecz /Naprzód): przesuwa kursor 
do wcześniej otwartego folderu.

Acquire (Pobierz): pobiera obrazy z TWAIN Datasource 
lub podłączonego na wtyk urządzenia

Print (Drukuj) powoduje drukowanie wybranych plików.

Stos (Grupuj w stos): powoduje zgrupowanie w stos 
wybranych plików Zgrupowane pliki będą zaopatrzone 
w strzałki W górę i W dół, umożliwiające przeszukiwanie 
plików w stosie.

Unstack (Rozgrupuj): rozkłada stos plików.

OCR: przeprowadza OCR pliku.

Save As (Zapisz jako): zapisuje kopię dokumentu w osobnym 
pliku.

PrzyciskPresto! Przycisk skanowania: Scan (Skan Presto!): 
kliknięcie powoduje umieszczenie skrótu na pasku Menu, 
przy użyciu którego można w łatwy sposób skanować. Więcej 
informacji zamieszczono w punkcie zatytułowanym, „Przyciski 
Presto! Scan” w dalszej części niniejszego rozdziału. 

Google Docs: powoduje wyświetlenie okna dialogowego, 
które umożliwia konfigurację danych uwierzytelniających 
skanowania bezpośrednio w Goggle Docs.

Evernote: powoduje wyświetlenie okna dialogowego, które 
umożliwia konfigurację danych uwierzytelniających 
skanowania bezpośrednio w Evernote.

Łącze do strony NewSoft: łączy ze stroną internetową 
NewSoft w celu uzyskania informacji o produkcie.

Łącze do strony Kodak Alaris: łączy ze stroną internetową 
Kodak Alaris w celu uzyskania informacji o produkcie.

Przełącz tryb podglądu: przełącza między widokiem Listy 
a widokiem Miniatur.

Okno Wyszukiwania plików: w celu wyszukania 
określonego pliku należy wprowadzić część nazwy pliku 
lub jego rozszerzenie W celu wyzerowania wyszukiwania 
należy oczyścić pole wyszukiwania i nacisnąć Enter.
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Zmiana ustawień paska 
narzędzi Polecenia 

Można zmieniać elementy paska narzędzi Polecenia, aby dopasować je do 
swoich potrzeb. 

1. Kliknijj View>Customize Toolbar (Wyświetl Personalizuj pasek narzędzi). 
Zostanie wyświetlony następujący ekran.

2. Przeciągnij ikony, które chcesz dodać do paska narzędzi lub z niego 
usunąć. 

3. Można wyświetlać te polecenia jako: Ikona i tekst, Tylko ikona lubb Tylko 
tekst; wybierz pożądaną opcję za pomocą listy rozwijanej Pokaż. 

UWAGA: Jeśli chcesz, aby wyświetlane ikony były mniejsze, kliknij pole 
wyboru Use small size (Użyj mniejszego wyboru). 

4. Kliknij przycisk Gotowe. 

Obszar wyświetlania Funkcja Obszar wyświetlania powoduje wyświetlenie plików w postaci miniatur 
lub pozycji listy.

Przełączanie między Widokiem miniatur a Widokiem listy odbywa się przy 
użyciu menu View (Widok) lub przez klikniecie ikony trybo przełączania 
widoków.
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Używanie folderów Kliknięcie folderu sprawia, że pliki w folderze będą wyświetlanie w obszarze 
wyświetlania w postaci miniatur. 

• Kliknij prawym klawiszem, aby pojawiło się menu skrótów. 

• Wybierz Properties (Właściwości) w celu zapoznania się z informacjami 
o folderze. 

• Kliknij dwukrotnie pasek Folders (Foldery), aby spowodować wyświetlenie 
lub ukrycie folderów

• Kliknij przycisk Back/Forward (Wstecz/Naprzód) na pasku narzędzi, aby 
przesunąć do wcześniej otwartego folderu. 

UWAGA: Folder Mój PageManager zawiera pliki próbne, które mogą posłużyć 
do ćwiczeń. 

Filtry Lista Filtry powoduje wyświetlenie typów plików. Wybierz typ plików, które 
mają byc wyświetlane w obszarze Wyświetlania Możliwe są następujące typy 
plików: JPEG, PNG, BMP, GIF, TIFF, PDF, RTF, HTML oraz XML. 

Kliknij dwukrotnie pasek Filtry, aby spowodować wyświetlenie lub ukrycie 
obszaru Filtrów.
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Używanie palety 
dokumentów 

Paleta dokumentów ułatwia gromadzenie obrazów i dokumentów, umożliwiając 
ich konwersję na PDF, wysłanie ich do określonej lokalizacji lub wysłanie 
pocztą elektroniczną. 

Paleta dokumentów przechowuje pliki tylko tymczasowo. Po wysłaniu pliku lub 
zamknięciu Presto! PageManager, pliki zostaną usunięte. 

UWAGA: Więcej informacji na temat zmiany ustawień Document Pallet 
Settings (Ustawienia Palety dokumentów).zawiera następny punkt.

Wyślij wybrane pozycje: umożliwia wysłanie jedynie 
wybranej (ych) pozycji w Palecie dokumentów do lokalizacji 
wyznaczonej w oknie Document Pallet Settings (Ustawienia 
Palety dokumentów).

Wyślij: kliknięcie tej ikony powoduje, że pozycje Palety 
dokumentów zostają skonwertowane na PDF i wysłane do 
określonej lokalizacji (np. folderu., poczty elektronicznej itd.), 
wyznaczonej w oknie Document Pallet Settings (Ustawienia 
Palety dokumentów). 

Settings (Ustawienia): powoduje wyświetlenia okna 
Document Pallet Settings (Ustawienia Palety dokumentów), 
które umożliwia zmianę miejsca, do którego są wysyłane 
zgromadzone obrazów oraz/lub dokumenty po kliknięciu 
ikony Send (Wyślij). 

Przesunięcie suwaka w lewo spowoduje zmniejszenie 
rozmiaru miniatur w oknie wyświetlania.
Przesunięcie suwaka w prawo spowoduje zwiększenie 
rozmiaru miniatur w oknie wyświetlania.

Przełączanie strzałki W górę/W dół w celu otwierania 
i zamykania Palety dokumentów. 
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Zmiana ustawień 
Document Pallet Settings 
(Ustawienia Palety 
dokumentów).

Ustawienia Document Pallet Settings (Ustawienia Palety dokumentów). można 
zmieniać klikając ikonę Settings (Ustawienia) Zostanie wyświetlone okno 
ustawienia Document Pallet Settings (Ustawienia Palety dokumentów).

• Wyślij dokument pocztą elektroniczną przez — wybierz aplikację email, 
której chcesz użyć do wysłania poczty. Dostępne opcje: Email, Microsoft 
Entourage lub Microsoft Outlook. Pliki do wysłania zostaną wysłane do 
wybranego programu. 

• Wyślij dokumenty do folderu — jeśli chcesz wysłać dokumenty do folderu, 
kliknij przycisk Browse (Przeglądaj) w określenia folderu, do którego 
zostaną wysłane pliki.

• Wyślij dokumenty do Google Docs — jeśli chcesz wysłać dokumenty do 
Google Docs, kliknij przycisk Browse (Przeglądaj) w celu określenia lokalizacji 
Google Docs , do której zostaną wysłane pliki.

• Wyślij dokumenty do Evernote — jeśli chcesz wysłać dokumenty do 
Evernote, kliknij przycisk Browse (Przeglądaj) w określenia lokalizacji 
w Evernote, do której zostaną wysłane pliki.

• Konwertuj dokumenty do PDF — jeśli chcesz przekonwertować 
zeskanowane obrazy do PDF, obrazy zostaną przed wysłaniem 
przekonwertowane. Przed wysłaniem PDF możesz dokonywać zmian 
w następujących ustawieniach:

- Save Document As (Zapisz dokument jako): możesz zdecydować, aby 
w tym samym pliku zapisać kilka dokumentów, możesz też zapisać je 
w odrębnych plikach klikając Save all documents in one PDF (Zapisz 
wszystkie dokumenty w jednym pliku PDF) lub Create a new pdf for 
each document (Utwórz dla każdego pliku nowy plik PDF).

- Rozmiar dokumentu: możesz zapisać plik korzystając z opcji Original 
Size (Rozmiar pierwotny) lub Fit to Page (Dopasuj do strony). Ta opcja 
jest dostępna tylko w przypadku plików graficznych.
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- OCR Options (Opcje OCR): wybierz jedną z następujących opcji OCR:

• Image (Obraz) - w celu zapisania w pliku PDF obrazu w aktualnej 
formie.

• Text and Image (Tekst i obraz) - w przypadku wybrania tej opcji, 
obraz zostanie przetworzony przy użyciu OCR a następnie w pliku 
PDF podzielony na tekst i obraz.

• Text Under Image (Tekst pod obrazem) - po wybraniu tej opcji 
przetwarzaniu przy użyciu OCR zostanie poddany obraz. Tekst 
i obrazy zostaną rozdzielone w pliku PDF na dwie odrębne warstwy, 
z obrazami na górze, a tekstem na dole. 

- Język OCR: jeśli wybierzesz opcję OCR dla Text and Image (Tekst 
i obraz) lub Text Under Image (Tekst pod obrazem), możesz wybrać 
język, w którym ma zostać zapisany plik. 

Po zakończeniu kliknij przycisk OK.

Pasek stanu Pasek stanu umożliwia wyświetlenie całkowitej liczby plików i informacji 
o miejscu na dysku w obszarze Display (Wyświetlacz).

Wybieranie źródła Jeśli w czasie uruchamiania PageManager jest podłączony tylko jeden skaner, 
zostanie automatycznie wybrany skaner. Jeśli jest podłączonych kilka skanerów, 
możesz wybrać, którego skanera chcesz użyć.

1. W celu wyświetlenia okna Select Source (Wybierz źródło) należy kliknąć 
File>Select Source (TWAIN) (Plik > Wybierz źródło (TWAIN)

2. Kliknij skaner, którego chcesz użyć, a następnie kliknij Select (Wybierz).
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Zmiana domyślnych 
ustawień skanowania 

Użytkownik może zmienić domyślne ustawienia skanera, aby dostosować je 
do swoich preferencji skanowania i wybrać używany profil, dodać do nazwy 
pliku prefiks i numer itd.

1. Kliknij File (Plik) >Scan Settings (Ustawienia skanowania). Zostanie 
wyświetlone okno Scan Settings (Ustawienia skanowania).
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2. Jeśli chcesz, możesz zmienić dowolne z poniższych ustawień:

• Prefix Name (Prefiks nazwy) — w polu Prefix Name (Prefiks nazwy) 
wpisz przedrostek poprzedzający nazwę pliku.

• Prefix Number (Liczba prefiksu) — PageManager automatycznie 
przypisuje kolejne numery w celu zapobiegania napisania plików. Jeśli 
chcesz, aby kolejne numery zaczynały się od liczby innej niż 000, 
należy wybrać numer początkowy.

• Save As Type (zapisz jako typ) — wybierz pożądany typ pliku, w którym 
chcesz zapisać obrazy. Dostępne opcje to: JPEG, TIFF, PNG, PICT, 
BMP i PDF. W przypadku wybrania ustawienia JPEG dostępne są opcje 
jakości: Przeciągnij suwak, aby ustawić jakość. 

• Hide Scanner Dialog Box (Ukryj okno dialogowe skanera) — zaznacz 
(lub odznacz) to pole, aby ukryć (lub wyświetlić Interfejs użytkownika 
TWAIN.

• Select Profile (Wybierz profil) — zawiera listę skrótów ustawień, które 
są aktualnie konfigurowane. Standardowo są dostępne następujące 
skróty ustawień:

- Default (Domyślne) — ustawienia domyślne skanera

- Black and White Perfect Page Document (Czarno-biały dokument 
Perfect Page)

- Color Perfect Page Document (Kolorowy dokument Perfect Page)

- Zdjęcie kolorowe

lub kliknij Manage Profile (Zarządzaj profilem), aby wyświetlić Skróty 
ustawień i umożliwić wprowadzenie dodatkowych zmian (np. dotyczących 
rozdzielczości). Opis tych ustawień skanowania zawiera Podręcznik 
konfigurowania skanowania. 

• Put Scanned Images Into (Umieść skanowane obrazy w) — pozwala 
na wybór miejsca, w którym chcesz umieścić obrazy powstałe w wyniku 
skanowania: w folderze My PageManager (Moja aplikacja 
PageManager) czy w aktywnym folderze. 

3. Po dokonani wyborów kliknij OK . 
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Akwizycja obrazów 
ze skanera 

Przed pobraniem obrazów sprawdź, czy zainstalowano sterownik skanera 
i czy skaner jest włączony i prawidłowo podłączony do Twojego komputera. 
Więcej informacji zamieszczono w dokumentacji Twojego skanera. 

1. Dokument(y) przeznaczone do skanowania należy umieścić na tacy 
wejściowej. 

2. Wybierz File>Acquire Image Data (Plik>Pobierz dane obraz). Skan 
zostanie wykonany, a zeskanowane obrazy zostaną zapisane w domyślnej 
lokalizacji. 

UWAGA: Fizyczne przyciski w skanerze nie współpracują z PageManager. 

Menu Presto! 
Przyciski 
skanowania: 

Informacje o Presto! Przyciski skanowania umożliwiają szybkie skanowanie 
zgodnie z jedna z wybranych opcji w menu Scan Buttons (Przyciski skanowania). 
Opcje dostępne w menu Scan Buttons (Przyciski skanowania) są dostosowywane 
do indywidualnych potrzeb za pomocą okna Scan Buttons Preference 
(Preferencje przycisków skanowania). Więcej informacji zamieszczono 
w punkcie zatytułowanym „Setting Scan Buttons Preference (Ustawianie 
preferencji przycisków skanowania Presto!)” w dalszej części rozdziału. 
Możesz używać przycisków skanowania albo otwierając wcześniej aplikację 
PageManager, albo jej nie otwierając. 

UWAGA: Przed uruchomieniem aplikacji PageManager sprawdź, czy Twój 
skaner jest podłączony do komputera. 

Jeśli ikona przycisku skanowania Presto! nie jest widoczna na pasku Menu, 
należy otworzyć aplikację PageManager i kliknąć Presto! Ikona przycisku 
Scan (Skanuj). Jeśli klikniesz tę ikonę na pasku Menu zostanie automatycznie 
umieszczony skrót.

1. Kliknij ikonę przycisku Scan (Skanuj) na pasku menu, aby wyświetlić menu 
Scan Buttons (Przyciski skanowania). 

• Możesz wybrać Select Source (TWAIN) (Wybierz źródło (TWAIN), aby 
wybrać skaner, którego chcesz użyć, jeśli podłączono więcej niż jeden 
skaner. Aby uzyskać więcej informacji, zobacz „Wybór źródła” 
wcześniej w tym rozdziale.

• Jeśli chcesz zmodyfikować ustawienia skanowania, możesz wybrać 
Open Presto! Scan Buttons Preferences (Otwórz Preferencje 
przycisków skanowania Presto!) 

• Jeśli wybierzesz Quit (Wyjdź), skrót przycisk skanowania Presto 
zostanie usunięty z paska Menu. 
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2. Dokument(y) przeznaczone do skanowania należy umieścić w skanerze.

3. W menu Scan Buttons (Przyciski skanowania) wybierz opcję, która ma być
zastosowana (lub miejsce, do którego chcesz wysyłać skanowane obrazy).

Opcje menu Scan Buttons 
(Przyciski skanowania

|Poniżej zamieszczono opis opcji i dostępnych zadań skanowania. Zobacz 
następny punkt zatytułowany „Ustawianie preferencji przycisków skanowania 
Presto!” 

Select Source (TWAIN) 
(Wybierz źródło)

Powoduje wyświetlenie okna dialogowego 
Select Source (Wybierz źródło), które umożliwia 
wybranie skanera, którego chcesz użyć.

Skanuj do PageManager Po skanowaniu obrazy zostaną umieszczone 
w aplikacji PageManager i będą mogły być 
otwarte w PageViewer. Więcej informacji na 
temat korzystania z PageViewer zamieszczono 
w Rozdziale 3.

Skanuj do BizCard 
Express

Po zeskanowaniu obrazy będą otwierane przy 
użyciu BizCard Express.

Skanuj do foldera Po zeskanowaniu obrazy będą wysyłane do 
wyznaczonego folderu, zdefiniowanego w Presto! 
Scan Buttons Preferences (Preferencje przycisków 
skanowania Presto!)

Skanuj do poczty Po zeskanowaniu obrazy będą wysyłane do 
wyznaczonego folderu, zdefiniowanego 
w Presto! Scan Buttons Preferences 
(Preferencje przycisków skanowania Presto!)

Kopiuj do druku Po zeskanowaniu zostanie wyświetlone okno 
dialogowe Print (Drukuj), umożliwiające 
drukowanie zeskanowanych obrazów.

Skanuj do OCR Po zeskanowaniu obrazy będą poddawane 
OCR i zapisywane w folderze zdefiniowanym 
w Presto! Scan Buttons Preferences 
(Preferencje przycisków skanowania Presto!).

Skanuj do pliku PDF Po zeskanowaniu obrazy będą konwertowane 
do |PDF i zapisywane w folderze zdefiniowanym 
w Presto! Scan Buttons Preferences 
(Preferencje przycisków skanowania Presto!).

Skanuj do Google Docs Po zeskanowaniu obrazy będą wysyłane do 
lokalizacji Google Docs zdefiniowanej w Presto! 
Scan Buttons Preferences (Preferencje 
przycisków skanowania Presto!).

Skanuj do Evernote Po zeskanowaniu obrazy będą wysyłane do 
lokalizacji Evernote zdefiniowanej w Presto! 
Scan Buttons Preferences (Preferencje 
przycisków skanowania Presto!).
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Ustawianie preferencji 
przycisków skanowania 
Presto! 

Możesz zmodyfikować ustawienia Presto! Scan Buttons (Preferencje 
przycisków skanowania Presto!). W oknie Presto! Scan Buttons Preference 
(Preferencji przycisków skanowania) są dwie zakładki: Scan Settings 
(Ustawienia skanowania) i Scan to Destination (Skanuj do miejsca 
docelowego). 

Zakładka Scan Settings 
(Ustawienia skanowania)

Użyj zakładki Scan Settings (Ustawienia skanowania) do wprowadzenia lub 
zmiany następujących ustawień. 

Hide Scanner Dialog Box (Ukryj okno dialogowe skanera) – jeżeli zaznaczono 
tę opcję, okno skanera Kodak nie będzie wyświetlane za każdym razem przed 
skanowaniem dokumentu, umożliwiając użytkownikowi wybranie Skrótu ustawień. 

Select Profile (Wybierz profil) — zawiera listę skrótów ustawień (profili), które 
są aktualnie skonfigurowane. Standardowo są dostępne następujące skróty 
ustawień:

• Default (Domyślne) — ustawienia domyślne skanera

• Black and White Perfect Page Document (Czarno-biały dokument Perfect 
Page)

• Color Perfect Page Document (Kolorowy dokument Perfect Page)

• Zdjęcie kolorowe

lub kliknij Manage Profile (Zarządzaj profilem), aby wyświetlić Skróty ustawień 
i umożliwić wprowadzenie dodatkowych zmian (np. dotyczących rozdzielczości). 
Opis tych ustawień skanowania zawiera Podręcznik konfigurowania skanowania.

Uruchom Presto! Scan Buttons (Przyciski skanowania Presto!), gdy 
uruchamiany jest system — zaznacz tę opcję, aby pokazać Presto! Scan 
Buttons (Przyciski skanowania Presto!) na pasku Menu w czasie rozpoczynania 
pracy przez komputer. 
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Lista zadan Na Liście zadań są wyświetlane predefiniowane zadania, które są wyświetlane 
w menu Presto! Scan Buttons (Przyciski skanowania Ptesto!). W większości 
przypadków te ustawienia spełnią wszystkie oczekiwania użytkowników. Jeśli 
stwierdzisz, że potrzebujesz dodatkowych zadań, możesz utworzyć własne 
zadanie. Twoje zadanie zostanie dodane do Listy zadań i będzie dostępne do 
użycia w przyszłości.

UWAGA: Lista zadań jest powiązana z zakładką Ustawienia kanałów i zakładką 
Skan do miejsca docelowego 

Dodaje kolejne zadanie do listy. 

1. Wybieranie zadania z listy, które jest podobne do zadanie, które 
chcesz dodać.

2. Kliknij ikonę Dodaj.

3. Dwukrotnie kliknij zadanie, aby wprowadzić nową nazwę.

4. Wprowadź wszystkie wprowadzane zmiany w zakładkach Scan 
Settings (Ustawienia skanów) i Scan to Destination tabs (Skanuj 
do miejsca docelowego).

5. Kliknij przycisk Apply (Zastosuj). 

Umożliwia usunięcie wybranego zadania. Nie można usunąć żadnych 
predefiniowanych zadań.

Za każdym kliknięciem strzałki w górę przesuwa wybrane zadanie 
o jedną pozycję w górę na liście. 

Za każdym kliknięciem strzałki w dół przesuwa wybrane zadanie 
o jedną pozycję w dół na liście. 

Przywraca ustawienia domyślne wybranego zadania.



A-61830_pl  Czerwiec 2014 r. 2-19

Zakładka Scan to 
Destination (Zakładka 
Skanuj do miejsca 
docelowego)

Zakładki tej należy używać w celu zmiany aplikacji, która ma być używana do 
otwarcia obrazy, skonfigurowania prefiksu i numeru kolejnego oraz zmiany 
miejsca docelowego o formatu pliku.

Open with application (Otwórz za pomocą aplikacji) — kliknij Browse 
(Przeglądaj), aby wybrać aplikację, którą chcesz wykorzystywać do podglądu 
pobrazu. 

Prefix Name (Prefiks nazwy) — w polu Prefix Name (Prefiks nazwy) wpisz 
przedrostek poprzedzający nazwę pliku.

Prefix Number (Liczba prefiksu) — PageManager automatycznie przypisuje 
kolejne numery w celu zapobiegania napisania plików. Jeśli chcesz, aby 
kolejne numery zaczynały się od liczby innej niż 000, należy wybrać numer 
początkowy.

Folder Path (Ścieżka folderu) — kliknij Browse (Przeglądaj), aby wybrać 
folder, w którym chcesz zapisać zeskanowane obrazy.

File Format — wybierz pożadany format zapisu plików. Dostępne opcje to: 
JPEG, TIFF, PNG, PICT, BMP, PDF, RTF, RTFD, HTML, format Word, format 
Word XML. 

Inne opcje będą dostępne w zależności od wybranej opcji. 

• W przypadku wybrania ustawienia JPEG dostępne są opcje jakości: 
Przeciągnij suwak, aby ustawić jakość.

• W przypadku wybrania ustawienia TIFF dostępne będą opcje kompresji.
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• W przypadku wybrania ustawienia PDF dostępne będą te opcje:

- Save Document As (Zapisz dokument jako): możesz zdecydować, aby 
w tym samym pliku zapisać kilka dokumentów, możesz też zapisać je 
w odrębnych plikach klikając Save all documents in one PDF (Zapisz 
wszystkie dokumenty w jednym pliku PDF) lub Create a new pdf for 
each document (Utwórz dla każdego pliku nowy plik PDF).

- Rozmiar dokumentu: możesz zapisać plik korzystając z opcji Original 
Size (Rozmiar pierwotny) lub Fit to Page (Dopasuj do strony). Ta opcja 
jest dostępna tylko w przypadku plików graficznych.

- OCR Options (Opcje OCR): wybierz jedną z następujących opcji OCR:

• Image (Obraz) - w celu zapisania w pliku PDF obrazu w aktualnej 
formie.

• Text and Image (Tekst i obraz) - w przypadku wybrania tej opcji, 
obraz zostanie przetworzony przy użyciu OCR a następnie w pliku 
PDF podzielony na tekst i obraz.

• Text Under Image (Tekst pod obrazem) - po wybraniu tej opcji 
przetwarzaniu przy użyciu OCR zostanie poddany obraz. Tekst 
i obrazy zostaną rozdzielone w pliku PDF na dwie odrębne warstwy, 
z obrazami na górze, a tekstem na dole. 

• Jeśli wybierzesz format RTF, RTFD, HTML, Word Format lub Word XML 
możesz wybrać język OCR, w którym ma zostać zapisany plik.

 

Gdy zakończysz wprowadzać zmiany, możesz:

• Kliknij OK w celu zapisania ustawień i zamknięcia okna. 

• Kliknij Apply , aby wprowadzić ustawienia.

• W celu odrzucenia zmian i zamknięcia okna, należy kliknąć przycisk Cancel 
(Anuluj).



A-61830_pl  Czerwiec 2014 r. 2-21

Drukowanie 
i przesyłanie faksem 

Niniejszy rozdział zawiera informacje i procedury potrzebne do zastosowanie 
tych funkcji:

• Konfigurowanie druku i wysyłania faksem

• Drukowanie

• Wysyłanie faksów

• Korzystanie z PrintFun

UWAGA: Sprawdź, czy zainstalowano sterownik drukowania lub faksowania i 
czy komputer komunikuje się z drukarką. 

Konfigurowanie druku 
i wysyłania faksem 

Przed użyciem drukarki lub faksu można sprawdzić lub zmienić właściwości 
drukarki/faksu. Przed użyciem drukarki lub faksu ustaw właściwości 
dostępnych urządzeń. 

1. Select File>Page Setup (Plik>ustawienia strony. Pojawi się okno dialogowe 
Page Setup (Konfiguracja strony).

2. Zmień na pożądane ustawienia (np. format, rozmiar papieru itd.|) 

3. Kliknij przycisk OK. 

Drukowanie W celu wydrukowania plików: 

1. Wybierz jeden lub więcej plików. 

2. Wybierz File>Print (Plik>Drukuj). Zostanie wyświetlone okno dialogowe 
Print (Drukuj)

3. Wybierz pożądane opcje drukowania i kliknij Print(Drukuj). 
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Wysyłanie faksów Jeśli masz faks modem z programem do faksowania, faksy możesz przesyłać 
bezpośrednio w PageManager. 

1. Wybierz plik, który chcesz wysłać faksem. 

2. Kliknij zakładkę Print, aby otworzyć program faksu. 

UWAGA: Szczegółowe instrukcje dotyczące tworzenia wiadomości wysyłanych 
faksem zamieszczono w dokumentacji programu do wysyłania faksów. 

Korzystanie z PrintFun PrintFun umożliwia drukowanie takich obrazów, jak zdjęcia, naklejki lub katalogi. 

1. Wybierz obrazy spośród miniatur w obszarze wyświetlania PageManager. 

2. Wybierz File>PrintFun (Plik>PrintFun). Zostanie wyświetlone okno 
dialogowe PrintFun

3. Wybierz ;liczbę wydruków dla każdego obrazu lub kliknij Set for all (Ustaw 
dla wszystkich), aby ustawić tę sama liczbę wydruków dla każdego obrazu. 

4. Kliknij przycisk OK. Zostanie wyświetlone okno dialogowe Select Page 
(Wybierz stronę).

5. Na rozwijanej liście możesz wybrać Photo (Foto), Sticker (Naklejka) lub 
Catalog (Katalog). W zależności od dokonanego wyboru, zostaną 
wyświetlone opcje drukowania obrazów. Na przykład jeśli wybierzesz 
Photo (Foto), możesz wydrukować obraz Letter (Full Page) (Format 
Letter, cała strona) (jeden obraz na stronę), Letter (4 x 6) (2 obrazy na 
stronę) lub Letter (L) (4 obrazy na stronę).
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UWAGA: Niezależnie od tego, czy wybierzesz Photo (Foto), Sticker 
(Naklejka) czy Catalog (Katalog), opcje w poniższych oknach 
dialogowych oraz procedury są mniej więcej takie same. 

6. Kliknij przycisk OK. Zostanie wyświetlone następujące okno dialogowe.

• Add page (Dodaj stronę) — spowoduje dodanie do układu dodatkowej 
strony, na której możesz umieścić więcej obrazów z listy miniatur.

• Delete page (Usuń stronę) — umożliwia usunięcie wybranej strony.

• Apply Range (Zastosuj zakres)c — w celu umieszczenie wielu kopii 
w układzie strony, wybierz obraz z listy miniatur i kliknij funkcję Apply 
Range (Zastosuj zakres) Następnie, kliknięcie komórki w obszarze 
podglądu powoduje wprowadzenie wybranego obrazu na stronę. 
Funkcja Apply Range (Zastosuj zakres) zawiera następujące opcje: 

• Select (Wybierz) — umożliwia przeciągnięcie obrazu z listy miniatur po 
lewej stronie, kliknięcie dowolnej komórki (szara ramka) powoduje 
umieszczenie pliku w wybranej komórce. 

Kopiuje wybrane zdjęcie w komórki, która została kliknięta. 

Kopiuje wybrane zdjęcie do każdej komórki w rzędzie 
klikniętej komórki.

Kopiuje wybrane zdjęcie do wszystkich komórek począwszy 
od komórki klikniętej do końca strony.
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• Opcje — powoduje wyświetlenie okna dialogowego Options (Opcje), 
które umożliwia poprawię jakości obrazu,m jego obrót, zmianę wielkości 
i wyrównanie obrazu lub dodanie do niego tekstu.

• Add more (Dodaj więcej) — powoduje wyświetlenie okna dialogowego 
Open (Otwórz), w którym możesz dodawać do tego układu inne obrazy.

• Delete (Usuń) — usuwa wybrany obraz z listy miniatur.

• Print (Drukuj) — powoduje wyświetlenia okna dialogowego Page Setup 
(Konfiguracja strony), umożliwiając wydrukowanie układu strony.

• Paper (Papier) — powoduje wyświetlenie okna dialogowego Paper 
(Papier), w którym jest wiele opcji utworzenia nowego układu strony. 
Można na przykład ustawić Cell Height (Wysokość komórki) i Cell 
Width (Szerokość komórki) tak, aby były identyczne jak wymiary kartki 
papieru i wpisać 0 zarówno dla Top Margin (Górny margines), jak i Left 
Margin (Lewy margines) lub wybrać zaokrąglone lub prostokątne 
narożniki obrazu.

UWAGA: Jeśli w czasie dokonywania wyborów w tym oknie dialogowym 
tło w obszarze podglądu stanie się czerwone, konieczna 
będzie modyfikacja wyborów tak, aby tło w obszarze podglądu 
stało się zielone. 
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• Layout (Układ strony) — powoduje powrót do okna dialogowego Select 
Page (Wybierz stronę), w którym możesz wybrać inny układ strony dla 
Twoich obrazów.

• Exit (Wyjdź) — zamyka PrintFun.

7. Jeśli układ strony spełnia oczekiwania kliknij Print (Drukuj). 

Przenoszenie faksów 
do folderu 

Jeśli masz możliwość korzystania z faksu, możesz skonfigurować folder 
wiadomości przychodzących, w którym można będzie sprawdzić, czy przyszły 
wiadomości. Wszystkie przesyłane faksy będą przenoszone do folderu 
wiadomości przychodzących. 

W celu konfiguracji folderu wiadomości przychodzących: 

1. Kliknij prawym klawiszem okno Folders (Foldery) i wybierz Properties. 
(Właściwości). Ten folder będzie Twoja skrzynką wiadomości 
przychodzących. 

2. Wybierz Set this folder as an inbox (Ustaw ten folder jako skrzynkę 
wiadomości przychodzących i kliknij Settings (Ustawienia). Zostanie 
wyświetlone okno dialogowe Inbox Settings (Ustawienia skrzynki 
wiadomości przychodzących). 

3. Pod Bring incoming documents to this inbox from, (Przenoś 
dokumenty przychodzące do tej skrzynki wiadomości przychodzących) 
wybierz folder faksów lub folder specjalny.

4. Kliknij Browse (Przeglądaj), aby wybrać folder faksów lub folder specjalnego 
przeznaczenia. Później faksy lub pliki w tym folderze zostaną przeniesione 
do folderu Inbox (Skrzynka wiadomości przychodzących).

UWAGI: 

• Pamiętaj, że folder faksów lub folder specjalny to nie to samo co folder-
skrzynka wiadomości przychodzących. 

• Nie używaj żadnego ze swoich folderów systemowych jako folderu 
faksów lub folderu specjalnego, mogłoby to spowodować przeniesienie 
plików systemowych i awarię komputera. 

5. Kliknij przycisk OK. Folder Skrzynka wiadomości przychodzących jest 
skonfigurowany i obok nazwy folderu będzie umieszczona flaga. 
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Robienie kopii 
zapasowych plików 

Aplikacja PageManager umożliwia robienie kopii zapasowych i odzyskiwanie 
ważnych plików. Pliki, których kopie tworzysz zostaną skompresowane i zapisane 
w specjalnym formacie w folderze kopii zapasowych, z którego mogą być 
łatwo odtworzone. 

1. W oknie Folder wybierz folder. 

2. Wybierz kolejno pozycje File (Plik)>Backup (Kopia zapasowa). Zostanie 
wyświetlone okno dialogowe Backup Settings (Ustawienia kopii 
zapasowych).

3. Kliknij Browse (Przeglądaj), aby zmienić Source Path (Ścieżka źródła). 

4. W polu Label wpisz tytuł, który ma dla Ciebie jakieś znaczenie, tak, aby 
można go było później łatwo odnaleźć. 

5. W polu Memo wpisz wszelkie inne użyteczne informacje, które będą mogły 
być wykorzystane jako odnośniki i do wyszukiwania. 

6. Kliknij przycisk OK. 

Odzyskiwanie plików W celu odzyskiwania plików z zapisaną zapasową:

1. Wybierz kopie plików, które chcesz odzyskać i kliknij File>Restore 
(Odzyskaj pliki). Zostanie wyświetlone okno dialogowe Restore (Odzyskaj).

2.  Odszukaj ścieżkę kopii zapasowych i kliknij OK. 
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3 Praca z PageViewer

Spis treści Menu Presto! Menu PageViewer ..............................................................3-2

Menu File (Plik) ..........................................................................................3-2

Menu Edit (Edycja).....................................................................................3-2

Menu View (Widok) ....................................................................................3-3

Menu Tools (Narzędzia): pliki obrazów ......................................................3-3

Menu Tools (Narzędzia): pliki PDF.............................................................3-5

Menu Annotation (Adnotacje): pliki obrazów..............................................3-6

Tworzenie pieczęciu............................................................................3-7

Menu Annotation (Adnotacje): pliki PDF ....................................................3-8

Menu Help (Pomoc) ...................................................................................3-8

Pasek narzędzi Polecenia..........................................................................3-9

Używanie OCR ........................................................................................3-10

Konwertowanie obrazu na tekst (OCR) z PageManager .........................3-10

Gdy wybierzesz i otworzysz plik z aplikacji PageManager, będzie on wyświetlony 
w Presto! PageViewer, gdzie możesz edytować plik i opatrywać go komentarzami. 

UWAGA: W zależności od typy otwieranego pliku, będą dostępne różne 
narzędzia. 
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Menu Presto! Menu 
PageViewer 

Menu Presto! PageViewer zawiera następujące opcje.

• Informacje o Presto! PageViewer — dostarcza informacji o Twojej wersji 
PageViewer. 

• Preferences (Preferencje) umożliwia wybranie języka, który będzie używany 
przez PageViewer do przetwarzania OCR. 

• Services (Usługi) — zawiera opcje No Services Apply (Nie mają zastosowania 
żadne usługi) lub Services Preferences (Preferencje usług). Jeśli wybierzesz 
Services Preferences (Preferencje usług), zostanie wyświetlony ekran 
Keyboard (Klawiatura), w którym można zmienić wiele różnych preferencji. 

• Ukryj Presto! PageViewer — po wybraniu aplikacja jest minimalizowana 
do Palety dokumentów. 

• Hide Others (Ukryj inne) — minimalizuje wszystkie inne aplikacje do Document 
Pallet (Paleta dokumentów). 

• Show All (Pokaż wszystko) — powoduje ponowne wyświetlenie wszystkich 
zminimalizowanych wcześniej aplikacji. 

• Quit Presto! PageViewer (Opuść Presto! PageViewer) — zamyka aplikację 
PageViewer. 

Menu File (Plik) Menu File (Plik) zawiera następujące opcje.

• Save (Zapisz) — zapisuje aktualnie wyświetlona stronę ze wszelkimi zmianami, 
które wprowadził użytkownik. 

• Save As (Zapisz jako) — umożliwia zapisanie strony z inna nazwą. 

• Page Setup (Ustawienia strony) — umożliwia zmianę ustawień drukarki lub 
faksu. 

• Print (Drukuj) — powoduje wyświetlenia okna dialogowego Print (Drukuj) 
(lub Fax - Faks), umożliwiając wydrukowanie dokumentu lub wysłanie go 
faksem. 

Menu Edit (Edycja) Menu Edit (Edytuj) zawiera następujące opcje.

• Undo (Cofnij) — anuluje ostatnią operację edycji.

• Redo (Powtórz) — powtarza ostatnią operację edycji.

• Cut — (Wytnij) usuwa wybrany plik lub część pliku z wyświetlacza i umieszcza 
go w schowku.

• Copy — (Kopiuj) umożliwia skopiowanie pliku i części pliku bez usuwania 
go z wyświetlacza i umieszcza go w schowku.

• Paste (Wklej) — powoduje wklejenie informacji, które zostały skopiowane 
lub wycięte do obszaru, w którym aktualnie znajduje się kursor.

• Delete (Usuń) — umożliwia usunięcie wybrane informacje. 

• Select All (Wybierz wszystko) — wybiera wszystkie informacje na temat 
wyświetlonego obrazu. 

• Find (Znajdź) — umożliwia wyszukiwanie słowa lub frazy na wyświetlonej 
stronie. 

• Spelling (Pisownia) — umożliwia zastosowanie następujących opcji 
sprawdzania pisowni w tym pliku: Show Spelling and Grammar, Check 
Spelling (Pokaż pisownię i gramatykę, sprawdzaj pisownię) oraz Check 
Spelling as you Type n (Sprawdzaj pisownie w czasie pisania. 
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• Start Dictation (Rozpocznij dyktowanie) — jeśli chcesz korzystać z tej funkcji, 
musisz włączyć Dictation and Speech (Dyktowanie i mowa) w Preferencjach 
Systemu. Skorzystaj z tej opcji, aby podyktować to, co chcesz powiedzieć, 
treść ta zostanie zamieniona na plik tekstowy. 

• Special Characters (Znaki specjalne) — wyświetla listę znaków specjalnych 
i symboli, które można dodać do Ulubionych.

Menu View (Widok) Menu View (Widok) zawiera następujące opcje.

• Hide/Show Toolbar (Pokaż/Ukryj pasek narzędzi) — powoduje wyświetlenie 
lub ukrycie paska narzędzi.

• Customize Toolbar (Dostosuj pasek narzędzi) — otwiera okno dialogowe, 
które umożliwia dostosowanie pozycji na pasku narzędzi do potrzeb 
użytkownika. Więcej informacji można znaleźć w punkcie „Zmiana ustawień 
paska narzędzi Polecenia” w Rozdziale 2.

Menu Tools (Narzędzia): 
pliki obrazów 

Jeśli masz plik w formacie innym niż PDF, dostępne są następujące opcje 
menu.

• Perform OCR (Przeprowadź OCR) — po kliknięciu wyświetlony plik zostanie 
poddany procedurze OCR. 

• Merge All Files into a Single PDF (Połącz wszystkie pliki w jeden plik PDF) — 
umożliwia połączenie wybranych plików w jedyny plik PDF. |W przypadku 
wybrania tej opcji użytkownik zostanie poproszony o wprowadzenie nazwy 
pliku i miejsca, w którym ma być zapisany plik. Przycisk Options (Opcje) 
jest dostępny w przypadku dokonania następujących wyborów:

- Save Document As (Zapisz dokument jako): Zapisuje wszystkie 
dokumenty w jednym PDF jest jedyną dostępną opcją.

- Rozmiar dokumentu: możesz zapisać plik korzystając z opcji Original 
Size (Rozmiar pierwotny) lub Fit to Page (Dopasuj do strony).

- OCR Options (Opcje OCR): wybierz jedną z następujących opcji OCR:

• Image (Obraz) - w celu zapisania w pliku PDF obrazu w aktualnej formie.

• Text and Image (Tekst i obraz) - w przypadku wybrania tej opcji, obraz 
zostanie przetworzony przy użyciu OCR a następnie w pliku PDF 
podzielony na tekst i obraz.

• Text Under Image (Tekst pod obrazem) - po wybraniu tej opcji 
przetwarzaniu przy użyciu OCR zostanie poddany obraz. Tekst i obrazy 
zostaną rozdzielone w pliku PDF na dwie odrębne warstwy, z obrazami 
na górze, a tekstem na dole. 

- Język OCR: umożliwia wybranie języka, który będzie używany do 
przetwarzania OCR.

• Rotate Left (Obrót w lewo) — umożliwia obrót obrazu o 90° w lewo.

• Rotate Right (Obrót w prawo) — umożliwia obrót obrazu o 90° w prawo.

• Skew Image Pochyl obraz— umożliwia pochylenie obraz pod kątem o kąt 
do 45 stopni w prawo lub o kąt 45 stopni w lewo. Obraz może być pochylany 
co 1. 

• Flip Image Horizontally (Obróć obraz horyzontalnie) — obraca wyświetlany 
obraz horyzontalnie.
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• Flip Image Vertically (Obróć obraz wertykalnie) — obraca wyświetlany 
obraz wertykalnie.

• Invert Color (Dokonaj inwersji kolorów)— zmienia czarne piksele na białe 
a białe na czarne.

• Remove Noise (Usuń szumy) — usuwa plamy z obrazu. Usunięcie plam 
może także poprawić sprawność OCR. 

• Adjust Color (Dostosuj kolor) — wyświetla okno dialogowe Adjust Color 
(Dostosuj kolor), w którym można zmienić ogólną kolorystykę obrazu

- Saturation (Nasycenie): przesuń suwak tak, aby uzyskać obrazy 
z kolorem tła, aby uzyskać obraz z bardziej jednolitym kolorem tła. 

- Jasność: umożliwia zwiększenie lub zmniejszenie jasności pikseli. 
Niska jasność da ciemne odcienie, natomiast wysoka jasność pozwoli 
otrzymać jaśniejsze, pastelowe odcienie.

- Kontrast: umożliwia wyostrzenie lub zmiękczenie obrazu. Zmniejszanie 
wartości tego ustawienia powoduje zmiękczanie obrazu i ograniczanie 
występującego na nim szumu. Zwiększanie wartości tego ustawienia 
zwiększa wyrazistość i jasność obrazu. 

- Poziom szumul: zmiękcza lub zaostrza obraz, 

- Ostrość: wyostrza krawędzie obrazu.

- Hue: (Odcień) pozwala na zmianę intensywności odcienia z szarego 
(brak nasycenia) do czystych żywych kolorów (wysokie nasycenie).

- Exposure (Ekspozycja): umożliwia podświetlenie lub przyciemnienie 
obrazu.

• Select Tool (Wybierz narzędzie) — pozwala na określenie części obrazu, 
którą chcesz poddać edycji.

• Move Tool (Narzędzie przesuwania) — pozwala na przesuwanie obrazu 
wokół obszaru wyświetlania, gdy obraz jest większy niż obszar wyświetlania.

• Prostokątne narzędzie wyboru — umożliwia rysowanie prostokąta wokół 
obszaru, który chcesz wybrać. 

• Crop (Przycinanie) — umożliwia usuwanie zewnętrznych elementów obrazu 
w celu poprawy obramowania.

• Eraser (Gumka) — umożliwia wybranie rozmiaru i koloru pędzla, którym 
usuwa się piksela w czasie przeciągania po obrazie. Jeśli chcesz możesz 
wybrać kolor, którym wypełnia się usuwane piksela.

UWAGA: Pasek narzędzi zawiera wiele tych samych z powyższych funkcji.

Wybierz
Przenieś

Prostokąt

Przytnij

Gumka
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Menu Tools (Narzędzia): 
Pliki PDF 

Jeśli wyświetlony jest plik PDF, dostępne są następujące opcje menu.

• Merge All Files into a Single PDF (Połącz wszystkie pliki w jeden plik 
PDF— opis tych opcji zamieszczono w punkcie zatytułowanym „Menu 
Narzędzia: pliki graficzne” wcześniej w tym rozdziale. 

• Split the Selected PDF File (Podziel wybrany plik PDF) — dzieli wybrany 
plik na jednostronicowe pliki PDF.

• Rotate Left (Obrót w lewo) — umożliwia obrót obrazu o 90° w lewo.

• Rotate Right (Obrót w prawo) — umożliwia obrót obrazu o 90° w prawo.

• Następna strona — przenosi na następną stronę w pliku.

• Poprzednia strona — przenosi na poprzednią stronę w pliku.

• Backward (Cofnij) — anuluje ostatnią operację edycji.

• Ponów — powtarza ostatnią operację edycji. 

• Select Tool (Wybierz narzędzie) — pozwala na określenie części obrazu, 
którą chcesz poddać edycji.

• Move Tool (Narzędzie przesuwania) —pozwala na przesuwanie obrazu 
wokół obszaru wyświetlania, gdy obraz jest większy niż obszar wyświetlania.

• Crop (Przytnij) — umożliwia wybranie fragmentu obrazu i odrzucanie 
pozostałej części. 

UWAGA: Pasek narzędzi zawiera wiele tych samych z powyższych funkcji.

Wybierz
Przenieś

Przytnij
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Menu Annotation 
(Adnotacje): pliki obrazów

PageViewer może ułatwić zaznaczanie plików. Możesz wpisywać, pieczętować, 
podświetlać, rysować lub dodawać uwagi. Możesz wybrać opcję z menu 
Annotation (Adnotacje) lub używać paska narzędzi Annotation (Adnotacje).

Show Lines (Pokaż linie) — powoduje wyświetlenie okna dialogowego Width 
(Szerokość), umożliwiającego wybranie szerokości linii, którą chcesz 
zastosować do rysowania.

Show Fonts (Pokaż czcionki) — powoduje wyświetlenie okna dialogowego 
Fonts (Czcionki), umożliwiającego dobranie typu, wielkości i koloru czcionki.

Show Fonts (Pokaż czcionki) — powoduje wy świetlenie okna dialogowego 
Fonts (Czcionki), umożliwiającego dobranie typu, wielkości i koloru czcionki.

Text (Tekst) — powoduje wyświetlenie okna dialogowego Font (Czcionka), 
umożliwiającego dodawanie komentarzy do obrazu.

Highlighter (Podświetlacz) — powoduje wy świetlenie okna dialogowego 
Color (Kolor)), umożliwiającego dobranie koloru używanego do podświetlania. 
W czasie gdy jest otwarte okno dialogowe Color (Kolor), możesz umieścić 
kursor w miejscu, w którym chcesz narysować prostokąt, aby zaznaczyć obszar. 

Freehand Line (Linia odręczna) — kliknij tym narzędziem obraz, jeśli chcesz 
narysować linię odręczna.

Straight Line (Linia odręczna) — kliknij tym narzędziem obraz, jeśli chcesz 
narysować linię prostą.

Stamps (Pieczęcie) — powoduje wyświetlenia okna dialogowego Stamp 
(Pieczęć), umożliwiając korzystanie z funkcji pieczęci. Więcej informacji 
zawiera następny punkt „Tworzenie pieczęci”.

Show Annotations (Pokaż adnotacje) — powoduje wyświetlenie (lub ukrycie) 
wszelkich adnotacji umieszczonych na obrazie.

UWAGA: Pasek narzędzi Annotation (Adnotacje) zawiera wiele tych samych 
z powyższych funkcji adnotacji.

Tekst

 Kolor

Odręczna

Prosta
Linia

Pieczęć
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Tworzenie pieczęci Możesz dodać obraz, dodać tekst, usunąć i zmieniać pieczęcie.

1. Wybierz Annotation>Stamps Pieczecie adnotacji), aby wyświetlić okno 
dialogowe Pieczęcie.

2. W celu dodania nowej pieczęci kliknij Add Image (Dodaj obraz) lub Add 
Text (Dodaj tekst) Zostanie wyświetlone okno dialogowe Add Image 
Stamp/Add Text Stamp (Dodaj pieczęć graficzną/Dodaj pieczęć tekstową)

3. Wprowadź nazwę obrazu/tekstu, który zamierzasz dodać.

4. Wprowadź lokalizację pliku graficznego w polu Stamp File (Plik pieczęci) 
lub kliknij Browser (Przeglądarka), aby wybrać plik. Wybrany plik zostaje 
wyświetlony w obszarze Preview (Podgląd).

5. Kliknij przycisk OK.
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Menu Annotation 
(Adnotacje): Pliki PDF

PageViewer może ułatwić zaznaczanie plików. Możesz wpisywać, pieczętować, 
podświetlać, rysować lub dodawać uwagi. Możesz wybrać opcję z menu 
Annotation (Adnotacje) lub używać paska narzędzi Annotation (Adnotacje).

Show Fonts (Pokaż czcionki) — powoduje wy świetlenie okna dialogowego 
Fonts (Czcionki), umożliwiającego dobranie typu, wielkości i koloru czcionki.

Show Colors (PPokaż kolory) — powoduje wyświetlenie okna dialogowego 
Colors (Kolory) umożliwiającego wybór koloru.

Oval (Owal) — umożliwia rysowanie na obrazie owalu. Po narysowaniu można 
zmieniać wielkość owalu i przesuwać go. 

Free Text (Tekst odręczny) — umożliwia wpisywanie tekstu na obrazie.

Note (Uwaga) — umieszcza ikonę Note (Uwaga) na obrazie, umożliwiając 
tworzenie adnotacji. Formę adnotacji na obrazie można zmieniać przez 
kliknięcie ikony Note (Uwaga), na której można zmienić kolor tła lub można 
zmienić ikonę Note (Uwaga) na inną (np. ikonę klucza lub ikonę paragrafu itp.).

Square (Kwadrat) — umożliwia rysowanie na obrazie kwadratu. Po narysowaniu 
można zmieniać wielkość kwadratu i przesuwać go.

Stamps (Pieczęcie) — powoduje wyświetlenie okna dialogowego Open 
(Otwórz), umożliwiającego wybranie pliku .png, który będzie użyty do obrazu. 

MarkUp (Zaznacz) — umożliwia wybór jednej z tych funkcji: Highlight Text 
(Podświetl tekst), Strikethrough Text (Przekreśl tekst) i Underline Text 
(Podkreśl tekst).

UWAGA: Pasek narzędzi Annotation (Adnotacje) zawiera wiele tych samych 
z powyższych funkcji adnotacji.

Menu Help (Pomoc) • Search (Szukaj) — umożliwia szukanie wśród pozycji menu i tematów 
pomocy.

• Link to NewSoft Website (Łącze do strony internetowej NewSoft) — 
zapewnia dostęp do strony internetowej NewSoft, na której można 
aktualizować produkty.

• Help (Pomoc) — otwiera plik pomocy online.

Oval 

Dowolny 

Uwaga

Square 

Pieczęć

Mark Up 

 opcja
(owal)

tekst
(Kwadrat)

(Zaznacz)
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Pasek narzędzi 
Polecenia 

Pasek narzędzi zawiera często używane funkcje. Funkcje te są dostępne 
także z paska Menu. 

UWAGA: Wyświetlane będą różne narzędzia, w zależności od typu pliku, który 
jest aktualnie w oknie aplikacji PageViewer. 

Powoduje powrót do aplikacji PageManager.

Umożliwia drukowanie obrazu(ów).

Zapisuje kopię dokumentu w osobnym pliku.

Obraca obraz o 90 stopni w lewo.

Przesuwa na następną stronę.

Przesuwa na poprzednią stronę.

Wyświetla aktualnie wyświetlaną stronę i pokazuje ile jest 
stron w pliku.

Cofa ostatnią operację na pliku.

Powtarza ostatnią operację na pliku.

Umożliwia modyfikację poziomów Nasycenia, Jasności, 
Kontrastu, Szumu, Ostrości, Odcienia i Ekspozycji.

Przeprowadza OCR pliku.

Łączy wszystkie wybrane obrazy w jeden obraz.
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Stosowanie OCR OCR (Optical Character Recognition)(Optyczne rozpoznawanie tekstu) jest 
mechanicznym lub elektronicznym przełożeniem obrazów drukowanego tekstu 
(zwykle zeskanowanego) na tekst możliwy do edycji.

Konwertowanie obrazów 
na tekst (OCR) 
z PageManager 

Jedną z funkcji aplikacji PageManager jest OCR Funkcja OCR umożliwia 
rozpoznawanie teksty w pliku graficznym i przetworzenie go na format tekstowy. 
Wynik OCR można zapisać w formacie PDF, RTFD lub Web Archive. Po 
zakończeniu rozpoznawania tekst można oglądać i edytować.

UWAGI:

• Wynik OCR w znacznym stopniu zależy od jakości obrazu. Przed 
rozpoczęciem OCR, można wybrać 300 do 600 dpi (File>Scan Settings in 
PageManager) (Ustawienia skanowania pliku w aplikacji PageManager) do 
skanowania obrazów, można też wybrać Tools>Noise Remove (Narzędzie 
usuwania szumów) w celu zmodyfikowania zeskanowanego obrazu. 

• Funkcja Noise Remove (Usuwanie szumów) usuwa z obrazu przypadkowe 
plamki i niewielkie kropki. 

 

1. Wybierz jeden lub więcej plików graficznych w obszarze Wyświetlania. 

2. Wybierz Tool>Perform OCR (Narzędzie>Przeprowadź OCR). 



Znak towarowy Kodak i postać 
handlowa są używane na podstawie 

licencji udzielonej przez firmę 
Eastman Kodak Company.

Kodak Alaris Inc.
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